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MICROSOFT EXCEL. 

This is application software classified as a spreadsheet. It is used to perform analysis on numerical data e.g. using 

formulas and functions to perform calculations, drawing charts etc. 

Excel which is a spreadsheet program can also be referred to as an application software used to calculate, organize 

and analyze numerical data 

 

Other types of spreadsheets programs include  

Corel Quattro Pro, Multi plan, Ms. Excel, OpenOffice Calc, iWork numbers, google sheets (cloud solution),  

VisiCalc – The first spreadsheet program to be developed 

Lotus 1, 2, 3- has been discontinued 

 

Sage and quick books are examples of financial accounting software  

FreshBooks is a cloud accounting software. 

 

Spreadsheets can be grouped into two 

i) Manual Spreadsheets – these are paper spreadsheets which are divided into rows and columns e.g. ledger book. 

ii) Electronic Spreadsheet - program that people use for storing, organizing and manipulating data. 
 

Benefits/Advantages of Spreadsheets. (Merits over Manual Spreadsheets) 

❖ Data can easily be moved, copied and deleted without messy erasures 

❖ Program is able to arrange or sort data correctly compared to manual spreadsheets 

❖ It has the ability to perform automatic recalculations. 

❖ Entries made are faster, neat and accurate 

❖ It has template facility that are used as a basis for other similar workbooks 

❖ Have inbuilt functions that enable the user to quickly manipulate mathematical data 

 

Demerits of Spreadsheets. 

• When a sheet is too long, it is not possible to view it at a glance on the screen 

• If a wrong formula is entered, it leads to incorrect results 

• A mistake in any value will affect the whole sheet 

 

Components of Spreadsheets 

 Worksheet: consists of rows and columns (cells) where data values are entered, a group of worksheets make 

up a workbook 

 Graphs: these are pictorial representations of the base data (data range) on a worksheet 

 Database functionality: Most spreadsheets have database functionality such as filtering, validation and 

sorting Features from database management systems incorporated into excel in the data tab e.g. pivot, query 

 

Running/Launching/Starting Excel. 

-Click start button 

-Click all programs, Under Ms. Office 

-Click Microsoft excel  
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The working area in excel is divided into rows (are numbered numerically) and columns (are labeled 

alphabetically. The intersection between a row and a column is called a cell and it’s in these cells that we enter data. 

Every cell is given a name/address or reference. Cells make > worksheets found in a > workbook. 

 

(Discuss Excel Interface: Ribbons, Formula Bar, cell pointer, Name box, Worksheet Tabs, status bar) 

 

Moving through the worksheet 

You can use the arrow keys/navigation keys and the mouse to move around the worksheet. 

Arrow keys: we use this to move towards the direction of the arrow one cell at a time e.g. up,  

Down, left and right. 

Mouse: Click on any to move to it 

 

Highlight/Selecting cells 

• You can always drag to select a range of cells e.g. A2 up to A10 

• CTRL + Shift + 8 

Highlights a range of cells/current region 

✓ Press Shift + 1st cell + last cell is also used to select a range of cells 

N.B: To select a whole column  

CTRL + spacebar while to select an entire row, click over any cell on the row and hit Shift + Spacebar 

 

Selecting Non-Contiguous ranges  

If you need to select cell that are not contiguous (i.e., ranges that are not necessarily next to each other), proceed as 

follows. 

✓ Select the first area of cells 

✓ Hold down the Ctrl key while selecting the other areas. 

 

Cell Data Types/Data entry 

There are three main categories of data that you can enter in your worksheet 

Labels e.g.  Name. 

Values e.g.20.  

Formula e.g. =A5 +A6 + A7 + A8 

Function e.g. =Sum (A5:A8) 

 

All functions are made up of three components  

The =sign indicates that the characters that follow are a function.  

The function name is the name of the function to be executed e.g. SUM  

The argument identifies the data to be used by the function and is always enclosed in parentheses e.g. (D4:D6) 

 

Application Areas of Spreadsheets 

- Accounting: used in maintaining important information such as sales, expenses e.tc 

- Scientific Applications: scientists store empirical data and complex mathematical models 

- Banking: calculating rates, loans and future expenditure 

- Home/Personal use: e.g. budgeting 

- Data management: e.g. use of tools like Forms, filtering and sorting 

- Forecasting (what if analysis) – used for predicting economic trends, budgeting, stock control 
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CALCULATIONS  

The power of excel is the ability to use Formulas and Function to perform on numeric values. 

Some of the calculations performed on numeric data include the following: 

When entering a formula or function you must start with the sign [=] 

For example, to perform calculations on values in cells A5 to A8 enter the following formulas and functions 

a) Additions-To add values in a number of cells, place the cursor in the cell to contain the answer and enter a 

formula or function. 

Formula: =A5+A6+A7+A8 

Function: You use the SUM function  

       =SUM (A5:A8)  

b) Multiplications – To multiply values in a number of cells, place the cursor in the cell to contain the answer and 

enter either a formula or function 

Formula: =A5*A6*A7*A8 

Function: You use the PRODUCT function 

      =PRODUCT (A5:A8) 

c) Average – To get average of values in a number of cells, place the cursor in the cell to contain the answer and 

enter the following function  

Formula: = (A5+A6+A7)/4 

Function: =You use the AVERAGE function 

          =AVERAGE (A5:A8) 

 

d) Maximum- The maximum function is used to get the highest value in a range of values  

      =MAX (A5:A8) 

e) Minimum- The minimum function is used get the lowest value in a range of values 

       = MIN (A5:A8) 

 

f) Subtraction- Use the formula to perform subtraction calculations among cells 

        =A5-A6-A7 

g) Division – Use a formula to perform division calculations among cells 

        =A5/A6  

 

Additional Examples of Inbuilt Functions 

 Statistical functions include (AVERAGE, COUNT, COUNTIF, MODE, MIN, MEDIAN, RANK, STDEV) 

 Logical functions include (IF, AND, OR, NOT)  

 Mathematical functions (SUM, PRODUCT, ROUND, SUMIF) 

 Financial functions (PMT, FV, NPV, RATE, PRICE) 

 Date and time functions (TODAY, NOW, DATE)   etc. 

 

Mathematical/Arithmetic formula Operators                  +, -, *, /, ( )  

Relational/Logical Operators     =, >, <, >=, < >     

 (Check Out Order of Execution) 

              Parenthesis, percent, Exponents, Division, multiplication, Addition and Subtraction.  

 

 

N.B:    To use Auto-sum, just select the whole data and press ALT + = 

 We can also sum single cell refs, ranges or constants e.g. =SUM(A10, B11:B15, 100)  
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FORMATTING CELLS 

To format cells simply highlight the cells and click on the button or command to perform the 

Needed format. You can use the formatting features in the Styles group in the Home tab  

Some other formatting may include: font type, font size, bolding, borders etc.  

 

Exercise 1 

Create the spreadsheet below 

 

 

                  

 

 

 

 

 

 

 

 

 

➢ Calculate the total, average, and minimum mark for each student. 

➢ Calculate the total, average and minimum mark for each subject 

➢ Center all column headings and their mark in the cells 

➢ Change the color of the column and row headings to red and bold them 

➢ Apply a bright green highlight color to all the data cells 

➢ Save your work on the desktop using the name assignment 1 

 

 

Formating numbers 

Use the following steps to format numbers in excel 

- Select the range of cells that contain numeric/values 

- Launch the format cells dialog box from the Number group of the Home tab 

- Under category Choose any number formats required e.g.  

General: the values will have no specific format 

Number: used for general display of numbers e.g. 875.5 

Currency: for displaying monetary values e.g. $450 

Accounting: lines up currency symbols and decimal points 

Date: displays dates in chosen format 

Time: displays time in chosen format 

Percentage: multiplies values in a cell by 100 and displays it as % 

Text: formats cells to be treated as text even when numbers are entered 

Custom: number formats not predefined in Ms. Excel can be defined here 

 

N.B: 

To collapse or expand the Ribbon CTRL + F1 

To toggle between formulas and values CTRL + ` OR Formula Tab > F. Auditing group > show formulas 

Practice Conditional formatting with icons sets found in the Home tab 

(Also Check out use of  from Arial font family under insert symbols by cell referencing and IF) 

 

 MATHS ENG BIO CHEM TOTAL MINIMUM 

JANE 45 60 54 78   

MARY 15 54 25 36   

SAM 78 55 63 57   

SARAH 47 87 65 32   

KIM 41 25 87 36   

LUKE 52 89 97 48   

TOTAL       

AVERAGE       

MINIMUM 
 
      

http://brooksict.orgfree.com/


http://brooksict.orgfree.com 

 

@Mr. Brooks Inc. 2020                                                                                                        

5 

Alignment 

In excel the are two alignment namely vertical and horizontal alignments. To align cells entries, do the following 

- Make sure the cells are highlighted 

- In the HOME tab 

- Under Alignment group 

- Set as desired 

 

Borders 

You can add borders to select cells. To do the following steps below 

- select the cells 

- Click the HOME tab 

- Click on borders 

- Select a border line style from the list  

- Select a border color  

- Click on the outline/inside to add the needed borders 

- Click OK 

 

Merging cells 

- Select the cells to be merged 

- In the HOME tab 

- Under alignment group 

- Click merge and center 

 

The Auto fill Handle 

-This is a small handle used to automatically fill a range of cell with data. The handle is found at the bottom right 

corner of the cell pointer. You can also use it to copy a formula from one cell to the other to enable automatic 

calculations in those cells. To use the auto fill handle move the cell pointer to it until it changes to a small black 

cross, hold down the mouse and drag. 

 

 Re-naming our worksheet. 

 -An excel workbook is made up of worksheets and every worksheet has a unique name e.g. Sheet 1  

At any given time, you can change the name of the sheet 

>Double click on its sheet tab then type the new name 

>Right-click on a sheet, choose rename and type the name 

 

Adding and removing worksheet parts 

1 To insert a column/row: Position the pointer where the new column/row should appear, on the Home tab ribbon, 

in the cells Group click Insert 

2. To insert a cell 

-Click on insert then cells and then indicate the direction of cells and click OK 
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Inserting/Deleting a worksheet 

To insert one or more worksheets 

- On the Home tab ribbon in the Cells group click Insert 

- On the dropdown list select Insert sheet 

N.B: You can also Delete a worksheet by right clicking the sheet tab then click the delete option on the shortcut 

menu 

 

Copying and pasting 

✓ Select the data to be copied 

✓ Click on Home Tab   

✓ In the Clipboard Group click COPY 

✓ Click on the first destination cell 

✓ Go back to the Home Tab and Click Paste 

 

Moving data/Cut 

✓ Select the data to be moved 

✓ Click on Home Tab   

✓ In the Clipboard Group click CUT 

✓ Click on the first destination cell 

✓ Go back to the Home Tab and Click Paste 

 

Copy shortcut is CTRL + C, Moving CTRL + X, Pasting is CTRL + V 

(Check out Auto format feature) 

IF STATEMENTS. 

-These are statements that are used to condition the computer to perform an action e.g. a calculation based on a 

certain condition. The statement must bear two possible actions that the computer must undertake on the basis of 

the condition given. The syntax for writing an IF statement is as follows 

=IF (CONDITION, TRUE/FALSE) 

-As they are used in calculations, IF statements must begin with an EQUAL sign followed by the if statement then 

give the condition, all the elements in an if statement must be separated by commas  

Example:  

If students had done an examination and they are to be graded so that those with 50 marks and above get a PASS 

and those with below 50 marks get a FAIL then the following IF statements will be written to do the grading 

=IF (A5>=50, “PASS”, “FAIL”) OR =IF (A5<50, “FAIL”, “PASS”) 
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Example:  

If you are awarding money according to the sex of the person so that a MALE gets 1500 and the female gets 1800, 

you will write the following statements 

=IF (A5= “MALE”, 1500, 1800)      OR =IF (A5= “FEMALE”, 1800, 1500) 

-You can also have the computer perform a calculation on values based on the condition that you give. 

Example: If you are to calculate the tax on gross pay where a male pays 10% of the gross pay while a female pays 

8% of her gross pay then you would write the following IF statement 

=IF (A5= “MALE”, 10%*B5, 8%*B5)    OR    =IF (A5= “FEMALE”, 8%*B5, 10%*B5) 

Where A5 is the cell with the sex status and B5 is the cell containing the gross pay amount 

Nested IF  

Syntax   =IF(CONDITION, TRUE, IF(CONDITION, TRUE, IF(CONDITION, TRUE, FALSE))) 

Example =IF(A5>100, “PASSED”, IF(A5>50, “AVERAGE”, “FAILED”)) 

 

EXERCISE 2 

 

EMPLOYEE SEX BASIC PAY  HOUSE ALL NHIF GROSS PAY NET PAY 

JOYCE F 23900     

PAT F 12870     

CHARLLY M 15450     

CHRIS M 23900     

MORRIS M 11000     

TERRY F 8900     

BOB M 17650     

 

CALCULATE: 

House allowance 

-Males get 15% of their Basic pay while females get 10% as their house allowances 

NHIF 

-Those earning a basic pay of over 1500 pay 7% while the rest pay 6.2% 

=IF (C2>1500, 7%*C2, 6.2%*C2) 

Gross pay 

=Basic pay + House Allowance 

NET PAY 

=Gross pay - NHIF  
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CHARTS/GRAPHS. 

Charts are drawn to represent any given numeric data in graphical form. You can draw a chart to the trend of a 

certain details. Types include line chart, bar chart, XY (scatter) chart, Column chart etc.  

Features of a Chart Titles, Labels, Data ranges and a Legend (shows specific information that are on the chart) 

 

To draw a chart, follow the steps below/Use the Chart wizard. 

✓ Highlight the data including the rows and columns 

✓ Click INSERT tab then select charts 

✓ Select the type of chart you want to draw e.g. Column, Bar etc. 

✓ Set the various desired chart options like legends, labels, chart title, axes then OK 

N.B: For pie charts you can only draw a pie chart for one item against many items and not many items against  

many items 

 

 

 

 

 

 

 

N.B: After selecting your data range (full) 

If you press F11, A chart will be created for you 

automatically 

 

  

check out sparklines select a row a choose any e.g. line, win/loss, column  

  

 
 

DATA MANAGEMENT. 

 

1. Sorting 

-This involves arranging data in an organized manner i.e. in ascending or descending order 

-select the data to be sorted then click Data tab, in the sort and filter group  

-click sort, define whether Ascending (A-Z) or Descending (Z-A)          

 

2. Filtering 

Filtering is a quick and easy way of finding and working with a subset of related worksheet.  

A filtered worksheet list will only display the rows that meet the condition or criteria you specify. Most excel 

versions have two commands for filtering 

- The Auto filter: it uses a simple criteria and includes filter by selection 

- Advance filter: it uses more complex criteria 

Procedure:  

- Click a cell in the list that is to be filtered, usually the list is in a column 

- On the DATA ribbon in the sort & filter group click the filter button 

 

 

Note: The blank and blanks options are available only if the column you want to filter contains a blank cell 

 

33%

23%

24%

20%

CYCLE 2 PHILLY PARIS

BUSHNELL FINA

IRENE ADONGO
OKEYO

JUDITH SABINA
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ii. Advanced filters 

-This is where you use an empty area in your worksheet to perform the filter process. Your worksheet should have 

at least three blank rows that can be used as a criteria range above the list range. The list must have a column labels. 

a) Criteria range: This refers to a cell range that contains a set of search conditions you can use with 

advanced filter command. It consists of one row of criteria labels (headings) and at least one row that 

defines the search conditions 

b) List range: It is a series of work sheet rows that contain related data from which you are filtering records. 

The first list range has labels (headings) for the columns 

 

 

3. FORMS. 

Are used for data input 

In the Quick access toolbar, you can add a form command 

 

Subtotals and grand totals 

Sort the data in ascending/descending order 

✓ Click a cell in the list, then on the DATA ribbon in the outline group click subtotal button 

✓ The subtotal dialog box pops up, in the at each change in dropdown list, select the field to use for grouping 

✓ In the use function dropdown list, select a function you want to use to create subtotals 

✓ In the Add subtotal to box, select the columns that contains values you want to subtotal…finally click OK 

 

Input validation 

✓ Highlight the range of cells to validate 

✓ On the DATA tab in the data tools group, click validation button 

✓ Click settings tab and set the criteria e.g. whole numbers 

 

EXAMPLE 3. 

Create the spreadsheet below and answer the questions that follow 

 

NAME SEX TOWN TRADE INCOME 

JOHN M KISUMU HAWKER 16000 

MARY F NAIROBI SECRETARY 24800 

JACK M NAIROBI DRIVER 17900 

JANE F MOMBASA HOTELIER 67960 

MARK M KISUMU DRIVER 20000 

JACOB M MOMBASA HAWKER 19876 

MILLY F KISUMU HOTELIER 48790 

THOMAS M NAIROBI MANAGER 58740 

 

1) Sort the list in descending order of their names, then by their sex and by their income. 

2) Using the auto filter feature filter all the records of all the people with income of above 45000/= 

3) Filter only those records with Kisumu residents 

4) Create a filter of the people earning an income of between 10000 and 20000  

5) Save your work using the name Assignment 
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REFERENCES. 

-These are used to identify a cell or a range of cells on a work sheet and tell excel where to look for the values or 

data to be used in a formula. References make it simpler to  perform calculations by copying formulas from one cell 

to another thereby saving the time of having to repeat the same formula now and again. 

-There are types of references namely 

a) Relative references: This is used to tell excel how to find other values to use in a formula by starting from the 

current cell. In this reference all the values in a formula will change as you copy the formula using the auto fill 

handle and as you move away from the current cells e.g. C10*E6 

b) Absolute references: This is where by some values in the formula will remain the same even as the formula is 

copied from cell to cell. That means that some values are going to be referred to wherever the formula is copied. 

When entering a formula with absolute references, the cells with those values that do not change are locked using a 

dollar sign ($).For example if cell A5 contains a value that is to be used a formula in many cells, it will be typed as 

$A$5  

C) Mixed cell reference: example =$D$10 * E6 

 

Practical. 

Saving and Printing a worksheet/workbook 

EXTRA WORK 

 Practice data validation 

Select the range > click Data tab > click Validation 

 Possible Error Messages  

e.g. ######, #NUM (Discussed under advance pages) 

 Function RANK 

e.g. 34, 55, 77, 23  

If 77 is in cell A3 then  =RANK(A3, A1:A4) would return 1 

   =RANK(A3, A1:A4,1) would return 4 

 Function SQRT 

=SQRT(C10)  

 

If C10 content is 25, then the function will return 5 

 

 To Hide Grid lines  View tab > show group > uncheck gridlines 

 
 Contextual tabs 

There are some tabs that appear in the ribbon only when you work on specific tasks. 

For example, when you create a chart, a Chart Tools section appears with two new Tabs 
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ADVANCED EXCEL 

 

1. MATH & TRIGONOMETRY FUNCTIONS 

✓ Sum If 

 

    =sumif(B7:B10, “Blue”, C7:C10)  Returns 15 

 =sumif(B7:B10, “< >Blue”, C7:C10) Returns 5 

 

✓ SumIfs 

Month Profits Quarter  

 Jan 5,000 Q1 

Feb 6000 Q1 

March 1000 Q1 

April 7000 Q2 

May 9000 Q2 

   

 

Find the sum of all Profits made in the 1st Quarter??? 

=sumifs(B2:B6, C2:C6, “=Q1”)    Will return 12,000/= 

 

✓ Modulus 

=MOD(3,2)  Returns 1 

=MOD(20,4)  Returns 0 

  N:B 

   If you use Quotient it returns the integer portion 

=QUOTIENT(20,4) Returns 5 

 

✓ SumSQ 

3, 10    =SUMSQ(A1,B1)  Returns 109 

2, 5        Returns 29  

✓ Round 

=round(B6, 3)  If the value in B6 is 28.1569 then it will return 28.157 

=round(B6, 2)  If the value in B6 is 28.1569 then it will return 28.16 

 

✓ Random  

In order to create a bunch of random numbers greater or equal to zero to 1 use 

 = Rand ( ) 

       In order to create a bunch of random numbers greater or equal to zero to 50 use 

 = Rand() * 50 

 

Or you can use = RandBetween (20,70) 

 B C 

7 Red 3 

8 Blue 5 

9 Black 2 

10 blue 10 
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✓ Base 

 

 =BASE(A2,B2)  Returns 1101110  

 =BASE(A3,B3)  Returns 62 

 

 

 =LOG(A5,B5)  Returns 3.3219 

 =LN(A5)   Returns 2.302 

 =LOG10(?)   ? 

 

  =ARABIC(A7)  Returns 10 

 

✓ LCM (Returns the Least Common Multiple)  

 A B 

1 2 5 

2 3 6 

3 5 8 

4 125 65 

 

=LCM(A2,B2) Returns 10 

=LCM(A3,B3) Returns 6 

 

✓ GCD (Returns the Greatest Common Divisor)  

=GCD(A4,B4)  Returns 5 

 

✓ Factorial (Returns the Factorial of a number, equal to 1*2*3*……..(no) 

=FACT(B2)  Returns 720,       5! Is 120  3! Is 6 

 

✓ TANGENTS AND RADIANS 

 

 
Hobbs is looking on top of a tree at an angle of 320 while the distance between him and the tree is 76 

meters, Find the height of the tree?  

   Height = 76 * tan (radians (32)) 

 Number Base 

2 110 2 

3 50 8 

4   

5 10 2 

6   

   

7 X  

8 IVV  
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2. ENGINEERING FUNCTIONS  

 

  

 

=Convert (cell, …. Choose unit, ……choose unit) 

e.g.  

=Convert (A2, inch, meters) 

 

 

 

=HEX2DEC(A1)  Returns 92 

=BIN2DEC(A2)  Returns 7 

=DEC2BIN(A3)  Returns 1111 

 

OR 

 

=DECIMAL(A4,B4)  Returns 10 

 

3. STATISTICAL FUNCTIONS 

 

✓ Sumproduct 

 

 Quantity Price  

2 3 2  

3 8 6  

4 1 5  

 =59 

 

=SUMPRODUCT(A2:A4,B2:B4) 

 

✓ Countif 

 

  

 

=countif(B7:B10, “B???”) Returns 2 

=countif(B7:B10, “B*”) Retruns 3 

 

 

 

 

✓ Count only counts VALUES but if you want to count TEXT use COUNTA 

✓ COUNTBLANK() function takes a single argument—a range of cells—and gives you the number 

of empty cells in that range 

 

 

 A B 

2 105  

3 50  

 A B 

   

1 5C  

2 111  

3 15  

   

 DATA BASE 

4 A 16 

   

 B C 

7 Red 3 

8 Blue 5 

9 Black 2 

10 blue 10 
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✓ Large(range, position) 

For example, if you specify a position of 1 with the LARGE() function, you get the largest item on the list, 

which is the same result as using MAX(). If you specify a position of 2, as in the following formula, you get 

the second-largest value: 

=LARGE(A2:A12, 2) 

Here’s an example formula that adds the three largest entries in a range: 

=LARGE(A2:A12,1) + LARGE(A2:A12,2) + LARGE(A2:A12,3) 

Assuming the range A2:A12 contains a list of monthly expenses, this formula gives you the total of your 

three most extravagant splurges. 

 

✓ Small()  

performs the opposite task by identifying the number that’s the smallest, second-smallest, and so on. For 

example, the following formula gives you the second-smallest number: 

 =SMALL(A2:A12, 2) 

 

✓ Frequency. 

it lets you define multiple ranges, and then, after chewing through a list of numbers, tells you how many values 

on the list fall into each range. 

 

A B C D E F 

Names score       frequency 

WERE 88       3 

KARDI 49 Range Upper limit   2 

PAUL 72 0-50 50   1 

LAURA 57 51-80 80   0 

WENDY 34 81-100 100     

BROOKS 20         

 

 The function  =FREQUENCY(B2:B7,D4:D6)   

The formula in cell F2 is an ARRAY FORMULA. For this formula to return values in cells F2, F3 and F4 

you must open this workbook in the Excel desktop program (not the web browser). In Excel, select cells F2, 

F3 and F4, press functional key 2 to switch the status bar from EDIT mode to ENTER mode, and then press  

CTRL + Shift + Enter. Otherwise, only a value in cell F2 will be returned. 

 

4. INFORMATION FUNCTIONS 

 
=ISBLANK(D2)  Returns TRUE or FALSE if cell D2 is blank or having something inside it 

=ISERR(D2)   Returns true for cells having errors and false for cells with no errors 

=ISEVEN(D3)/ISODD Returns true if the value of cell D3 is even/odd 

=ISNUMBER(D4)  Returns TRUE if cell D4 contains a number 

=ISTEXT(D5)   Returns TRUE if cell D5 contains text 
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5. LOGICAL FUNCTIONS 
 

     

 

  =AND(C1*C2=32) Returns TRUE 

  =OR(C1=4,C2=7) Returns TRUE 

 

   

 

=IFERROR(A1/B1, “kunaerror”) 

N.B: If it finds NO ERROR it will return the results else it will display your message 

 

  

 

=IF(SUM(E3:F3)>18, “OLD,”YOUNG”) 

 

To check if cell E4 is more then 10,000 and also less then 90,000 at the same time without using  

two Ifs function   i.e. 10,000 – 90,000 

 

  =IF(AND(E4>10000, E4<90000), “TRUE”, “FALSE”) 

 

If value in cell A1 is not zero, multiplies A1 by the value in B10, otherwise displays blank text 

 

=IF(A1< > 0, A1 * B10, “  “ ) 

 

6. TEXT FUNCTIONS 

 

 

 =concatenate(B10, “ ”,C10) Returns Jesse Lingard 

 OR 

 =B10& “ “&C10 

 

The UPPER function converts text to uppercase 

=UPPER(B10) 

LOWER does the opposite 

 

The trim function 
The TRIM () and CLEAN () clean up any strings of text you run through them. TRIM () 
removes any leading and trailing spaces; it also changes any series of more than one space to a single space. 
N.B: More TEXT functions examples at the back 

 

 A B C 

1 200 0 4 

2   8 

3    

 E F 

3 15 20 

4 11000 7000 

 B C 

10 Jesse Lingard 

11 19 69 
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7. LOOKUP & REFERENCE 
Question: Find the marks for Thor in Maths 

 

 A B C D 

1 Names Maths English physics 

2 Lucky 99 12 90 

3 Thor 72 89 91 

4 Munni 92 96 84 

5 sheila 69 65 56 

 

 Solution: 

 A B 

 Name Maths 

1 Thor =VLOOKUP(A1,A1:D5, 2, 0) 

 

 

 Because Maths is in Column 2   0 or 1 for exact match 

 

 Syntax: 

  =Vlookup(lookupvalue, table array, col_index, [range lookup]) 

 

 (Check out hlookup) 

 

8. DATABASE FUNCTIONS. 
Question: calculate the number of H.P Computers remaining in Stock 

 

 A B C D E F 

6 Computer HDD Processor Memory Quantity Prices 

7 Acer 1000 2.7 8 10 1100 

8 Lenovo 750 2.4 6 5 950 

9 HP 750 2.3 16 8 1500 

10 Asus 500 3.0 4 20 800 

11 Acer 1000 2.1 6 5 1800 

12 HP 750 2.0 8 4 750 

13 Lenovo 750 2.7 6 2 2500 

 

Solution: 

 A B C D E F 

1 Computer HDD Processor Memory Quantity Prices 

2 HP      

 

Syntax:  =DSUM (database, field, criteria) 

 

  =DSUM (A6:F13, E6, A1:F2)   Returns 12 

N.B: If cell A2 is left blank then it will return no. of stock for all the products i.e. 54 
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9. FINANCIAL FUNCTIONS 

 
Before you start using Excel’s financial functions, it helps to understand the financial concepts that lie at the 
heart of many of these operations. Here are some terms that those wacky accountants love to use: 
• Present Value (PV). The value of an investment or loan at the very beginning of its life. (Hopefully, after 
this point, the investment will rise or you’ll begin to pay off the loan.) This number’s also called the principal. 
• Future Value (FV). The value of an investment or loan at some point in the future. 
• Rate. The rate at which an investment or loan will increase or decrease. A typical investment could have 
an annual interest rate of 5 percent, which means that after one year, the future value will be 5 percent 
larger than the present value. 
• Payment (PMT). An amount of money you contribute to an investment or loan. It’s a regular contribution, 
usually made at the same time as the interest on the investment or loan is calculated. 
• Number of Payment Periods (NPER). The total number of payment periods between the present value and 
the future value of an investment or loan. If you’ve got a three-year car loan (with payments due monthly), 
the NPER equals 36—in other words, there are 12 payment periods each year, for 3 years. 

 

The FV Function 
 

 

FV calculates the future value of a fixed investment earning a fixed interest over a specified period. 

 

Example 1 

let’s say, you want to plan for your retirement in 20 years and decide to invest Ksh. 20,000 each year.  If the 

investment pays 20% interest compounded annually, the formula would be: 
 

=FV(20%,20,-20000) 
 

You would collect Ksh. 3,733,760 after 20 years. 

 

Example 2 

 Mr. Brooks invested 50,000 on PS4 that matures after 3 years and pays 4% interest. How much will the PS4 

 grow to after 3 years??? 

 

Sln: present value is 50,000, no of payment periods is 3 yrs, I =4%, PMT=0, Type is blank 

 =FV(4%,3,0,-50,000) 

  

 N.B: Its -50,000 because it’s an outflow 

 

 

FV (rate, nper, pmt, pv, type) 

 

Returns the future value of an investment based on periodic, 

constant payments and a constant interest rate. 

 

Type: if you are going to make payments at the begging of the 

period use 1 else 0 or omit if payment is at the end of the period 

(beginning or end of the month) 

 

=FV(5%/12, 2*12, -100, -10,000, 1) 

=FV(B2/12, B3*12, -B5, -B1, 1) 

 A B 

1 Principal 10,000 

2 Interest rate 5% 

3 years 2 

4 Payment/yr 12 

5 Monthly payment 100 
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✓ If I invest 1,000/= in the bank at a 5% interest rate for 6 years. How much money will I have after 6 years? 

Mathematically it would be 

 =1000 * (1 + 5%) 6 

 =1,340 

 

THE PMT FUNCTION  

calculates the payment for a loan based on constant payments and a constant interest rate. 

 

Syntax    =PMT(rate, nper, pv) 

 

Rate: interest rate for the loan 

Nper: total no of payments for the loan 

Pv: present value/PRINCIPAL 

 

N.B:  If you make monthly payments on a 4 year loan at an Annual interest rate of 12 then 

  =PMT(12%/12, 4 * 12, ……….) 

 If you make an Annual payment on the same loan then 

  =PMT(12, 4,……..) 

To find the total amount paid over the duration of the loan,  

multiply the returned PMT value by NPER 

 

Example;  

 

A businessman took out a Ksh. 800,000 loan for 4 years at an annual Interest Rate of 26%, compounded 

monthly.  If the monthly installments are paid on the last day of each month, determine the installment to be 

paid 

. 
 

=PMT(800000,0.26/12,48) 

 
 

The Monthly installment is 26,973.85 

 
 

Note.  The Interest is divided by 12 in order to get the monthly rate, and term (in years) is multiplied by 12 

to convert it into months. 

 

 Tip    To find the total amount paid over the duration of the loan, multiply the returned PMT value by nper. 

 

 

 

 

 

 

 

 

 

Data  Description   

8% Annual interest rate  
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Data  Description   

10 Number of months of payments  

$10,000 Amount of loan  

   

Formula  Description  Result  

=PMT(A2/12,A3,A4) Monthly payment for a loan with terms specified as arguments in A2:A4. ($1,037.03) 

=PMT(A2/12,A3,A4) 
Monthly payment for a loan with with terms specified as arguments in 

A2:A4, except payments are due at the beginning of the period. 
($1,030.16) 

   

   

Data  Description   

6% Annual interest rate  

18 Number of months of payments  

$50,000 Amount of loan  

   

Formula  Description  Live Result  

=PMT(A12/12,A13*12, 

0,A14) 
Amount to save each month to have $50,000 at the end of 18 years. ($129.08) 

 

 

The Net Present Value Function  
is a more specialized function that can help you decide whether to make an investment or embark on a business 
venture by calculating net present value. To understand net present value, you first need to understand the 
concept of present value, which is the value that a projected investment has today. If you have an investment 
that earns 5 percent monthly interest and is worth $200 at maturity (after one month), its present value is 
$190.48.  
 
Syntax: =NPV (rate, value1, value2, ...) 
 
Returns the net present value of an investment based on a discount rate and a series of future payments 
(negative values) and income (positive values) 
 

Here’s how to calculate the net present value of the four-year investment: 

 

=NPV (5%, 2000, 6500, 10000, 12500) 

 

Excel counts each cash flow as one period. Thus, this formula covers four periods. 

Because the calculation uses an annual interest rate (5%), each period represents a full year. The formula returns a 

result of $26,722.61. In other words, to generate the same amount of money as your business will, you’d need to 

invest $26,722.61 initially at an annual interest rate of 5 percent.  
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10.   DATE FUNCTIONS 
 

Today ( )  - returns todays date that is automatically updated with the system date i.e. 17-Oct-19 

Now ( ) - returns todays date and time together 17-Oct-19 08:24 pm 

 

If cell C5 is having a date value e.g. 17-Oct-19  

 

Then   =day(c5)  returns 17 

  =month(c5) returns 10 

  =year(c5) returns 2019 

 

Adding/deducting Dates 

If Glen borrowed a book on 17th October 2019 and return date is after a week, calculate the return date? 

If cell C5 is having a date value e.g. 17-Oct-19   

 

=C5 + 7 

 

If Rashford returned a book on 17th October 2019 and took one week with it, calculate the day he borrowed the 

book? 

  =C5 – 7 

Adding/deducting months 

When it comes to months then we twerk the functions a little bit………. we use EDATE 

              
 

  Adding 2 months     deducting 2 months 

 

Adding/deducting Years 

Let’s add 10 years to our date……. returns 17-Oct-2029 

 
 

N.B:  Note that in a Year we have  52 weeks, all Saturdays and Sundays are 104…….therefore 

 365 days – 104 days means we have 261 working days 

      will return 261 with no holidays specified. 
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How to find network days with holidays 

 

 
 

Calculating age difference 

 
 

 

To find months’ fix M, for days’ fix D 

 

Calculating no of days remaining within  

 

         =Days(enddate, startdate) 

 or   =Datedif(startdate, enddate, “D”) 

                                       =MONTH(Serial) 

Which Week of the Month? 

 

Can be answered using the date function, it will return an integer e.g if today is 17th Jan, returns 3 (week 3) 

=WEEKNUM(NOW()) 
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MORE TIPS 

 

 
 

 

 

 

The status bar combines several types of information. The leftmost area shows Cell Mode, which displays one 

of three indicators: 

• Ready means that Excel isn’t doing anything much at the moment, other than 

waiting to execute a command. 

• Enter appears when you start typing a new value into a cell. 

• Edit means you currently have the cell in edit mode, and pressing the left and right arrow keys moves 

through the data within a cell, instead of moving from cell to cell. You can place a cell in edit mode or take it 

out of edit mode by pressing F2. 
 

FLASH FILL 

 
 

Once it figures out a pattern, it will do the rest if you press CTRL + E OR on the HOME TAB click Flash fill 

      N.B: Check out use of Text to Columns from the DATA TAB explained Below   
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PASTING WITH TRANSPOSE 

 
 

 

PASSWORD PROTECTION 

 

Protection can be done in Excel in 3 ways 

➢ Password protection for the whole workbook 

▪ File menu > Info > Protect workbook 

➢ Password protection for the worksheet/during data entry 

▪ Review Tab > Changes Group > Protect sheet 

➢ Looking few cells and leaving others for Data entry 

▪ Select the range you want to remain editable 

▪ Go to the Font drop_down and uncheck locked option under protection 

▪ Finally go to the Review Tab > Changes group > protect sheet 

 

 

 

N.B:  You can create your own Excel functions by writing a series of instructions using  

VBA (Visual Basic for Applications) code. 

 

How to Create a Drop-Down list. 
 

First select the column cells, go to the Data Tab and click Data Validation.  
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What-IF Analysis 
 

1. Using Scenario manager 

 

Assuming that you are working for the company and the 

management would like to know in December if they can 

increase/decrease the discount % depending on the market 

price……. you can create best, current, and worst case 

scenarios plus create a summary to study the Total loss 

through the cases. 

Data Tab > Forecast group > what if analysis > scenario 

manager 

 

2. Goal Seek. 

Often used in cases where you know the End Results but you don’t know how to get there 

 

 
 

 

N.B: In order to change several cells, use Solver 

 

3. How to use the Solver in Excel for Data Analysis. 
 

- Solver is a Microsoft Add-In Program you can use for what-if analysis to find an optimal (max/min) value for a 

formula in one cell (called the objective cell) subject to constraints on the other cells. 

- To activate it, go to File, excel options, manage Add-ins, activate the Solver Add-in. 

- The objective cell must always have a formula.  

- If you want the value of the objective cell to be as large as possible, use max. if you want it to be as small as 

possible use min or set a value to a certain desired number. 

- To create a report that is based on your solution after solver finds a solution, you can click a report type in the 

report box then click OK. 
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Sample question 1. 

 

Assuming the parents had an initial budget in column D of 15,000, copy the same content to column E. 

Let both totals to be calculated totals…. assuming they have Re-adjusted the budget and now they would like to 

calculate How much money to Allocate now that they have 60,000.  

 

 Set objective to cell E9, Value to 60k, by changing cells in column E, finally click OK 

  Data Tab > Analyze group > Solver 

 

 
 

 

Solution: 

 
- You can choose any of the following three algorithms/solving methods in the solver parameters dialog box. 

Generalized Reduced Gradient (GRG): this is the most commonly used method to solve non-linear 

problems. It looks for a local optimal solution. 

 LP Simplex: used to solve problems that are linear 

Evolutionary: This is used to solve more complex and non-smooth no-linear problems. It looks for a global 

optimal solution which makes it take longer to run compared to GRG 

 

 

N.B: Compare with Goal seek which only allows you to change one value  

http://brooksict.orgfree.com/


http://brooksict.orgfree.com 

 

@Mr. Brooks Inc. 2020                                                                                                        

26 

Sample Question 2: 
How many purchases are we able to make if we intend to spend only 15,000/= on the available items. 

N.B: The money spent should not be more than the value of items Available in the store. 

 

 
 
Set the total money spent as your objective, to a value of 15,000 by changing cells in purchase column.  

Then finally set the constraints such that the money spent shouldn’t be more than the number of items in the store. 

Solution: 

 
 
WORKING WITH TABLES. 
After entering the data below, it was formatted as a table named Table4 in SHEET 1 
 

 
Thereafter to generate the total below in SHEET 2, the following function was used 

 

 

 

 

 
 =SUM(Table4[ENG]) 

N.B: Any changes made in the table is reflected on the totals in sheet 2  
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USING EXCEL FORECAST FUNCTION. 
 

 

 

The first argument in forecast function is X, for this we need to select what is the next period i.e. next month 

number in our example which is B8,  

next argument is known as Ys, this is nothing but what is the revenue already archived so far in the previous 

months i.e. C2:C7 and they must be absolute reference.  

The final argument is known as Xs, for this we need to select previous month numbers i.e. B2:B7 and they must be 

absolute reference. 

There after close the bracket and press enter and auto fill. 

 

INDEX Function 

Is used to get the value of a cell in a given table by specifying the number of the row or column or both that you are 

looking for e.g. to get the name of an employee at the 5th row below, =INDEX(C4:C9,5,2) it would return MATA 
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HOW TO COMBINE MULTIPLE WORKSHEETS. 

Two or more worksheets can be linked in one new worksheet that can be automatically refreshed/updated whenever 

a change is done in any of the sheets. 

- First select the Data from both tables and format them as tables 

            Home Tab > Styles group > format as table 

- Go to the Data Tab, under get and transform group click from table 

 

 
 

- Then close and load to > under load to choose, only create connection 

- Repeat step 2 and 3 for the second sheet and have all of them having connections to your 

workbook. 

- Under Data tab click New Query, choose combine queries and Append sheet 1 to 2 or vice-

versa 

- Done, make any change you wish 

- There after close and load as table in your workbook 

 

DATA CONSOLIDATION  
Same results can be achieved by using data consolidate command on the DATA TAB, Marks for Comp studies in 

Sheet 1 for term 1, sheet 2 term 2 can be consolidated in sheet 3 as totals for term 3 
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ADDITIONAL CONCEPTS. 
✓ Functions can be nested together, for example 

=IF(ISERROR(A7), “ELIGIBLE”, A7) 

 

If it finds an error in cell A7, it will display ELIGIBLE else it will display the number 

 

Ex: If cell A7 is having values on revenues and we are trying to check if the value is more than 15,000 but less 

than 20,000, then 

 

  =IF(AND(A7>15,000, A7<20,000), “Revenue within budget”, “Revenue out”) 

 

✓ To change an array of values in all cells selected, type the new value in the 1st cell then press  

CTRL + ENTER and all the selected cells in the array will change to that new types value 

 

✓ Linking worksheets 

e.g. =A7 + SHEET2!A10 

 

✓ Inserting comments 

Helps other who are less familiar with the worksheet or even the designer can recall specific info in the future 

 

✓ Freezing panes 

VIEW TAB > Window group > freeze panes 

 To freeze any specific row press ALT + W + F + R, column ALT+W+F+C 

 

✓ To switch between windows 

VIEW TAB > Window group > switch windows  

 

✓ GOTO special is used to select all blanks cells in a range  

(for deletion or to have same content using CTRL + ENTER) 

 

Select the data set > Home tab, editing group > click Goto special > select Blanks and click Okay 

 

✓ To Use Format Painter more than once – Double Click the Format Painter and use it as many times as you 

like. When you’re done press ESC. Only applies in Excel 2007 and higher.  

 

✓ Synchronous Scrolling – want to compare two workbooks and have them both scroll at the same time? With 

two workbooks open > View tab of the ribbon > View side by side > Synchronous Scrolling  
 

✓ How to find and format duplicates in your worksheet 

Select the whole data range > Home tab > conditional formatting > highlight cells rules > Duplicate values 

After this you can use the Remove duplicate command in the data tab…. 

N.B: It only works when the full row is a duplicate i.e. if Row 3 full is same as maybe Row 7 full 

  

✓ PIVOT Table 

Use it to compare different columns and rows in tables, use recommended pivot tables and try out the slicers to 

filter data 
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✓ BAR CODES: can be input directly into cell values after you download the barcode font and install it….       

 
N.B: 

Obviously, once you go beyond 26 columns, you run out of letters. Excel handles this by doubling up 

(and then tripling up) letters. For example, after column Z is column AA, then AB, then AC, all the way to AZ 

and then BA, BB, BC—you get the picture. And if you create a ridiculously large worksheet, you’ll find that 

column ZZ is followed by AAA, AAB, AAC, and so on 

 

✓ If you choose Home→Cells→Format→AutoFit Column Width, Excel automatically sizes the column to fit the 

content in the current cell. Or you can select a group of cells and use this command to size the column to fit the 

widest value in the group. 

 

✓ In Excel 2010, there are a total of 1,048,576 ROWS, with 16,384 COLUMNS [Ranging A-XFD] 

 

✓ Watch window in excel is used to watch for changes in the formulas we use while working with a large 

amount of data and formulas.  

 

✓ Excel Power Query is used for searching data sources, making connections with data sources, and then 

shaping the data according to our analyzing requirement. Once we are done with that we can also share our 

findings and create various reports using more queries. Fundamentals Combine, transform, combine, manage. 

 

✓ Ratio is one of the common methods used to compare two values. 

  OR 

 
 

✓ Types of pointers in Excel 

a.  Doctor’s symbol (Big Plus) 

b.  small thin plus icon 

c.  Mouse Pointer with anchor at the tip 
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✓ TEXT FUNCTIONS CONTINUED. 

 

 
 

=LEN(B2)     =MID(B2,1,4)  =LEFT(B2,1) =RIGHT(B2,5) 

 

✓ MORE ON ARRAYS 

An array formula can perform calculations on more than one cell in an array. You always finish an array formula 

with CTRL+SHIFT+ENTER, not just ENTER. Pressing CTRL+SHIFT+ENTER calculates the function against the array. 

When you're done, Excel puts special brackets { } around the formula. These brackets are a visual clue that the 

selected cell is part of an array formula. You can't type these brackets yourself. Excel puts them in when you press 

CTRL+SHIFT+ENTER.  

✓ Someone filled three cells with yellow. You can sort the rows by that color. Right-click a yellow cell, and then click 

Sort > Put Selected Cell Color on Top.  
 

 

✓ Instead of using flash fill to separate columns, we could use text to columns option from the data tab 
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THE CHOOSE FUNCTION 
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Hide Non-Used Cells on your Worksheet. 

Select the last column or row, use the shortcut CTRL + SHIFT + Left Arrow, there after right click and click HIDE  

 

 

 

ERRORS IN EXCEL 

 Correct a ##### error 

This error occurs when a column is not wide enough, or a negative date or time is used. 
 Review the following possible causes and solutions.  

The column is not wide enough to display the content 
1. Select the column by clicking the column header.  

2. On the Home tab, in the Cells group, click Format, and then click AutoFit Column Width.  

 
TIP ALTERNATIVELY, you can double-click the boundary to the right of the column heading. 

3. Select the column.  

4. On the Home tab, in the Cells group, click Format, click Format Cells, and then click the Alignment 

tab.  

5. Select the Shrink to fit check box. 

Dates and times are negative numbers 
▪ If you are using the 1900 date system, dates and times in Microsoft Office Excel must be positive 

values. 

▪ When you subtract dates and times, make sure that you build the formula correctly. 

▪ If the formula is correct but the result is still a negative value, you can display the value by formatting 

the cell with a format that is not a date or time format.  

1. On the Home tab, in the Cells group, click Format, click Format Cells, and then click the 

Number tab.  

USED CELLS 

UNUSED 

CELLS 
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2. Select a format that is not a date or time format. 

 

 

 Correct a #DIV/0! error 
This error occurs when a number is divided by zero (0). 

1. Optionally, click the cell that displays the error, click the button that appears , and then click Show 

Calculation Steps if it appears.  

2. Review the following possible causes and solutions.  

Entering a formula that contains explicit division by zero (0) — for example, =5/0 
Using the cell reference to a blank cell or to a cell that contains zero as a divisor 

▪ Change the cell reference to another cell.  

▪ Enter a value other than zero in the cell used as a divisor.  

▪ Enter the value #N/A into the cell referenced as the divisor, which changes the result of the formula to 

#N/A from #DIV/0! to denote that the divisor value is not available.  

▪ Prevent the error value from displaying by using the IF worksheet function. For example, if the 

formula that creates the error is =A5/B5, use =IF(B5=0,"",A5/B5) instead. The two quotation marks 

represent an empty text string.  

Running a macro that uses a function or a formula that returns #DIV/0! 
 

 
 
 

 Correct a #N/A error 
This error occurs when a value is not available to a function or formula. 

1. Optionally, click the cell that displays the error, click the button that appears , and then click Show 

Calculation Steps if it appears.  

2. Review the following possible causes and solutions.  

Missing data, and #N/A or NA() has been entered in its place 
Giving an inappropriate value for the lookup_value argument in the HLOOKUP, LOOKUP, MATCH, or 

VLOOKUP worksheet function 
Using the VLOOKUP, HLOOKUP, or MATCH worksheet function to locate a value in an unsorted table 
Using an argument in an array formula that is not the same number of rows or columns as the range 

that contains the array formula 
Omitting one or more required arguments from a built-in or custom worksheet function 
Using a custom worksheet function that is not available 
Running a macro that enters a function that returns #N/A 

 

 Correct a #NAME? error 
This error occurs when Microsoft Office Excel doesn't recognize text in a formula. 

1. Optionally, click the cell that displays the error, click the button that appears , and then click Show 

Calculation Steps if it appears.  

2. Review the following possible causes and solutions.  

Using the EUROCONVERT function without the Euro Currency Tools add-in being loaded 
1. Click the Microsoft Office Button , click Excel Options, and then click the Add-ins category.  

2. Select Excel Add-ins in the Manage list box, and then click Go.  

3. In the Add-Ins available list, select the Euro Currency Tools check box, and then click OK. 

Using a name that does not exist 
Misspelling the name 
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Misspelling the name of a function 
Entering text in a formula without enclosing the text in double quotation marks 
Omitting a colon (:) in a range reference 
Referencing another sheet not enclosed in single quotation marks 

 
 

 Correct a #NULL! error 
This error occurs when you specify an intersection of two areas that do not intersect. The intersection operator is a 
space between references. 

1. Optionally, click the cell that displays the error, click the button that appears , and then click Show 

Calculation Steps if it appears.  

2. Review the following possible causes and solutions.  

Using an incorrect range operator 
▪ To refer to a contiguous range of cells, use a colon (:) to separate the reference to the first cell in the 

range from the reference to the last cell in the range. For example, SUM(A1:A10) refers to the range 

from cell A1 to cell A10 inclusive. 

▪ To refer to two areas that don't intersect, use the union operator, the comma (,). For example, if the 

formula sums two ranges, make sure that a comma separates the two ranges 

(SUM(A1:A10,C1:C10)). 

Ranges do not intersect 
▪ If there are no squares at each corner of the color-coded border, then the reference is to a named 

range.  

▪ If there are squares at each corner of the color-coded border, then the reference is not to a named 

range. 

5. Double-click the cell that contains the formula you want to change. Microsoft Office Excel highlights 

each cell or range of cells with a different color.  

6. Do one of the following:  

▪ To move a cell or range reference to a different cell or range, drag the color-coded border of the 

cell or range to the new cell or range.  

▪ To include more or fewer cells in a reference, drag a corner of the border.  

▪ In the formula, select the reference, and type a new one.  

7. Press ENTER.  

8. Do one of the following:  

▪ Select the range of cells that contains formulas in which you want to replace references with 

names.  

▪ Select a single cell to change the references to names in all formulas on the worksheet.  

9. On the Formulas tab, in the Defined Names group, click the arrow next to Define Name, and then 

click Apply Names.  

10. In the Apply Names box, click one or more names.  

 

 Correct a #NUM! error 
This error occurs with invalid numeric values in a formula or function. 

1. Optionally, click the cell that displays the error, click the button that appears , and then click Show 

Calculation Steps if it appears.  

2. Review the following possible causes and solutions.  

Using an unacceptable argument in a function that requires a numeric argument 
Using a worksheet function that iterates, such as IRR or RATE, and the function cannot find a result 
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▪ Use a different starting value for the worksheet function.  

▪ Change the number of times Microsoft Office Excel iterates formulas.  

1. Click the Microsoft Office Button , click Excel Options, and then click the Formulas 

category.  

2. In the Calculation options section, select the Enable iterative calculations check box.  

3. To set the maximum number of times that Excel will recalculate, type the number of iterations in 

the Maximum Iterations box. The higher the number of iterations, the more time that Excel 

needs to calculate a worksheet.  

4. To set the maximum amount of change that you will accept between calculation results, type the 

amount in the Maximum Change box. The smaller the number, the more accurate the result 

and the more time that Excel needs to calculate a worksheet.  

Entering a formula that produces a number that is too large or too small to be represented in Excel 
 
 
 
 
 
 
 
 
 
 

 Correct a #REF! error 
This error occurs when a cell reference is not valid. 

1. Optionally, click the cell that displays the error, click the button that appears , and then click Show 

Calculation Steps if it appears.  

2. Review the following possible causes and solutions.  

Deleting cells referred to by other formulas, or pasting moved cells over cells referred to by other 
formulas 

Using an Object Linking and Embedding (OLE) link to a program that is not running 
Linking to a Dynamic Data Exchange (DDE) topic such as "system" that is not available 
Running a macro that enters a function that returns #REF! 

 
 

 Correct a #VALUE! error 
This error occurs when the wrong type of argument or operand is used. 

1. Optionally, click the cell that displays the error, click the button that appears , and then click Show 

Calculation Steps if it appears.  

2. Review the following possible causes and solutions.  

Entering text when the formula requires a number or a logical value, such as TRUE or FALSE 
Entering or editing an array formula, and then pressing ENTER 
Entering a cell reference, a formula, or a function as an array constant 
Supplying a range to an operator or a function that requires a single value, not a range 

▪ Change the range to a single value.  

▪ Change the range to include either the same row or the same column that contains the formula.  

Using a matrix that is not valid in one of the matrix worksheet functions 
Running a macro that enters a function that returns #VALUE! 
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